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Create Tomorrow Together
MAX Sneaks

Portfolio Tours

Product Tutorials

MB100 - Adobe MAX Keynote: Create
Tomorrow Together (OCT 26)

S707 - Shaping Your Style via Personal
Projects to Boost Your Career (OCT 27)

S613 - Designing for First-Glance Attention (OCT 26)

MB180 - MAX Sneaks with
Kenan Thompson (OCT 27)

S711 - Brand Identities in Motion (OCT 27)

S327 - Imagining Illustrator on the
Web: Sneak Preview (OCT 28)

Creative Operations
S259 - Creating Richer Digital Experiences
with Creative Workflows (OCT 26)
L260 - Building an Efficient Design
and Approval Workflow (OCT 27)
S213 - Data-Driven Creativity: Using
Data to Propel Creative Work (OCT 27)
S252 - Eyes Wide Shut: Taking Visual
Out of Visual Design (OCT 28)
S211 - Three Best Practices for Growing
an In-House Agency (OCT 28)
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S326 - Seeing Beyond the Colors (OCT 27)
S301 - Making Money Creating Digital
Products with InDesign (OCT 27)

Trending Design
S717 - SUX: The Sustainable
UX Manifesto (OCT 27)
S362 - Bringing More Style to Your
Typography and Designs (OCT 27)
S614 - Type Trends: 2022 and Beyond (OCT 27)
S380 - Discovering How to Have
Fun with Color Fonts (OCT 28)

S324 - What’s New in Illustrator: New Features, Updates, and More (OCT 26)
L330 - New Ways to Make 3D Artwork in Illustrator (OCT 26)
S812 - Typography, Play, and Animation (OCT 27)
L200 - Learning the Fundamentals of PDF Accessibility Step by Step (OCT 27)
S619 - Getting Design Done: How to Manage Projects Less and Create (OCT 27)
L577 - Improving Efficiency with After Effects Power Tips (OCT 27)
L332 - Designing Scalable Marketing Assets with Illustrator (OCT 27)
L714 - Making MOGRTs with Mo and After Effects (OCT 28)
S203 - Creatives Are Not Robots: Letting Automation Do That for You (OCT 28)
S558 - Creating an Animated and Interactive Infographic (OCT 28)
S358 - Essential Editing Techniques for Creating Realistic Composites (OCT 28)
L369 - Advanced Compositing for Brands, Photography, and Type (OCT 28)
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MAX Sneaks
MB 100 -

Adobe MAX Keynote: Create
Tomorrow Together
Expanding Adobe Sensei into more of what you love, like:
— Content-aware background fill
— Sky replacement
— Smart portrait
Previewing the newest features of the Adobe CC Suite
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MAX Sneaks
MB 18 0 -

MAX Sneaks with Kenan Thompson
Adobe Sensei applications:
— Use ON POINT to search Adobe Stock for photos
of people while querying a specific pose
— Use SHADOW DROP to dynamically apply
realistic shadows to objects
— Use Illustrator’s PROJECT SUNSHINE to trace sketches,
colorize, and shade the artwork automatically
— Use Illustrator’s STYLISH STROKES to automatically
generate font inlines and apply brushes to font fills
(previously had to hand-trace to do)
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— Also use STYLISH STROKES to create typographic
illustrations and replace type pieces with certain
graphics (like vertical strokes become columns,
horizontal bases become brick walkways)
— Use PROJECT STRIKE A POSE to apply a person’s
pose from one photo onto another photo
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MAX Sneaks
S327 -

Imagining Illustrator on the Web
Design is about navigating how to make ideas into artwork.
It’s also about the back-and-forth designer and client
relationship—design is increasingly collaborative!
However, Illustrator had been originally designed to be “single player.” The
ILLUSTRATOR FOR WEB BETA now allows online easy for easy sharing.
Advantages:
— Designers can now access Illustrator wherever.
— Clients can now view work instantly via Share web link.
New Features:
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— Infinite zoom
— Fast, even for big and heavy files
— Live Preview of Pathfinder options
If you’re interested in joining Illustrator on the web
(private Beta), please fill out this form.
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Creative Ops
S259 -

Creating Richer Digital Experiences
with Creative Workflows
Main Points:
— Draw viewers into message
— Authentic / inclusive imagery allows users to see themselves represented
— Keep users engaged (e.g. a backgroud video keeps
attention while highliting something in front)
— Lead eyes through creative
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Creative Ops

2. Desde Acrobat
En Acrobat cuando el documento no
tiene etiquetas se utiliza la herramienta
de Preparar Formulario y se arrastran al
documento los campos requeridos.

2. From Acrobat
In Acrobat, when the document does not
have tags, the Prepare Form tool is used
and the required fields are dragged to the
document.

Después escoger el rol de la persona que va a
llenar el formulario.

L260 -

Building an Efficient Design and Approval Workflow
Vanessa Cardozo Rojas and Rafael Hidalgo y Teran Estrada | Adobe MAX 2021

Building an Efficient Design &
Approval Workflow
Design a Design Request form
Director Designs a Form for
Accounts People to Submit Creative
Requests to the Design Dpt

Share within Microsoft
Teams to Collect Accounts’
Creative Requests

Create form in InDesign, imported into

Create Design Proofs

Acrobat to add interactivity/fillable fields

Use Library Assets to”

Building an Efficient Design and Approval Workflow
Vanessa Cardozo Rojas and Rafael Hidalgo y Teran Estrada | Adobe MAX 2021
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— create a cup design in
Illustrator then Arc warp it
for a cup wrap-around

Create reusable form
fields with Adobe Sign
Import the PDF as a web
form to create the fields

— add Illustrator template to
Photoshop as a Smart Object
and mock-up on cup

Set form collector as Delegator,
user as Acceptor

Building an Efficient Design and Approval Workflow
Vanessa Cardozo Rojas and Rafael Hidalgo y Teran Estrada | Adobe MAX 2021

16

Top

— open an InDesign template
for Design Approval form

Once Adobe Sign generates
the textbooks, drag-drop into
the Acrobat document
These Adobe Sign fields can also
be saved as Library Assets and
added in following InDesign docs

Then choose the role of the person who will
fill out the form.

w/mock-ups

Share within InDesign Share
Link to Collect Comments

Be sure to assign Delegator/Acceptor
to field or Adobe Sign says there’s
an error with the web form
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Creative Ops
S213 -

Data-Driven Creativity: Using
Data to Propel Creative Work
Start with the end in mind and
determine WHY you want to measure
what you want to measure

Best practices:
— Avoid an over-abundance of data;
creates confusion and waste
— Avoid bad segmentation of data

Why Use Data-Driven Creativity

— Keep it simple; find top 2 or 3 things
and focus on parsing out that data,
clarifying it, and communicating it well

Helps creative deliver on the highest
levels of the organization’s goals
Data often doesn’t show up in design,
there’s aspiration but no discipline to do it
Strategic advantages of data
Data sheds light on things that
are unknown and provides:

— Keep it actionable; have a plan
and a commitment to take
action and make sure that everyday
you’re appropriately managing
your resources based on that data

— Visibility on the unknown, working
less on feeling and more with facts
— Quantification and add some
weight to observations
— Validation: allows you to communicate
with authority about problems and/
or successes your team is countering
Key challenges the data starts to solve:
Reduces unplanned revision cycles,
reduces unnecessary requests

Top
What do you need to measure
to be successful?
— ACCOUNTS: ratio of planned vs.
unplanned projects
— CREATIVES: project completion times

Where should a designer start?
Try to think about the whole, interdepartmental picture
Become aware and skilled of understanding
the purpose of the other parts of the business
Business goals: production shop
vs strategic workshop?
Schedule and optimize projects
according to business goals
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— Keep it relevant; not about “what
data do we have” but what data
do we need to measure as a business
or a team to keep moving forward?

— PROJECT MANAGERS: rounds
of revisions
Creatives should ask how did an
asset perform? Did it do well, perform
high, and resonate? If it wasn’t highperforming, what can be done better?

Timesheets are the most valuable tool to
measure the time creatives take to complete
projects to fully understand what the
time segmentations look like to be more
efficient: discovery, design, revisions, etc.
Who’s sending the most amount of work?
Who’s sending the least?
Are the right creative people working
on the right projects—not based on
their availability but by their talent?

Creative Ops
S252 -

Eyes Wide Shut: Taking Visual
Out of Visual Design
Visual memory can inform the senses in
ways we can take for granted. Constant
visual stimulus can undercut creativity.
See what tasks you can perform without
seeing. It can be richer, more grounded
approach to problem-solving.

How to assess whether tools are
problem solvers or problem creators
— Is it sustainable? Can this be
carried on without you, or are you
the only one who can use this tool?
— Is is scalable? Can you take
this solution and multiply it?

What is “transformative design?”

— Is it sharable? Can you take this
tool / skillset / solution and share it
with others? Or is it “proprietary”?

Fundamental concept is closing down visual
stimulus to access visual cortex in order
to find other avenues to problem-solve.
Most important aspect is choosing the right
tool. Don’t get personally attached to a tool.
Rather than looking at a tool and seeing
what problems you can solve with it, try
the inverse: think about how to work the
problem then select the tool. Understand
the purpose behind the work you’re doing.
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Ways to practice “shutting your eyes” to
get stronger visual communication
Find something that is a physical activity
and makes something—don’t rely on
visual stimulus. Activities can include:

Diversify your knowledge base. Don’t become
attached to one skillset or program.
Process
— Identify the problem
— Select a tool
(e.g. Mockshop instead of XD)

— Folding origami blindfolded
— Drawing blind contouring
with blocked view
— Drawing from memory while blindfolded
— Tying your shoes
— Braiding your hair
— Whatever tactile process
you’re deeply familiar with
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Creative Ops
S211 -

Three Best Practices for Growing
an In-House Agency
Set a business goal:

What’s next:

Transition from support function (inhouse agency to parent co.) to strategic
partner (standalone agency)

— Make sure teams are just as
excited about the next 5 years
— Lean into external offerings—
picking up projects and skills they’d
like to lean into for the future to
greater value across the
business during the slow times

To get started:
— Teams needed to understand the value
of the KPIs and departmental goals

— Empower teams to scale their
own skillset and capabilities and
fell that although they’ve got Liberty
as #1, that they’ve got other options
to continue growing their careers

— Got started with great project
managers and designers already
— Helpful that roles were already
clarified and empowered
— Employees should be able to leave
the company and continue their career
growth; they should be competitive and
that helps the agency grow forward too

10
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Book recommendation: Done
Right Tomorrow’s Leaders by
Alex Shootman on Amazon

— Less complex structure
but high-value offering
— Really lean on their operational model
and make sure everyone’s in sync
— Enables us to lean into
in-source more work in the future
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Portfolio Tours
S707 -

Shaping Your Style via Personal
Projects to Boost Your Career
Make time for yourself
Explore passions, materials, subjects, lighting
Slower but freer and gives opportunities to learn how to do new things
Many commercial projects stemmed from her personal
work/style, so she was able to take it further there
VIEW PALOMA RINCÓN’S PORTFOLIO SHARE-SQUARE
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Project Idea:

Photograph a
colorful product
display
LARA LEE
L ARALEE . DES I G N

12
Top

Portfolio Tours
S7 11 -

Brand Identities in Motion
Movements convey brand tone (mellow, straightforward, chaotic)
She just described her creative challenges with individual projects
All her samples were variable type animations with a custom
font and Autodesk Sketchbook (so not even Adobe?)
VIEW LIZA ENEBEIS’ PORTFOLIO SHARE-SQUARE
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Project Idea:

Animate
variable type
LARA LEE
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Portfolio Tours
S326 -

Seeing Beyond the Colors
I came in halfway, so I saw a tour of his personal
motion design portfolio and passions
VIEW ZIPENG ZHU’S PORTFOLIO SHARE-SQUARE
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https://drive.google.com/open?id=1efSZFVE-kwaYs_EyUa3TIcqdE9Kr
Top
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Portfolio Tours
S301 -

Making Money Creating Digital
Products with InDesign
Why Digital Products
— Passive income

Which One Is Best for You
*Speaker Responses
— Who is looking for your product?
Online businesses

— Make your own hours (flex)
— Work remotely

— Why do they need it?
Limited on time • Not creativelyinclined • They hate staring at a
blank page

— Helps others
— Allows you to work on projects you enjoy
— Great even if you don’t excel
at designing 1 design: 1 specific
client (or excel at client diplomacy)

— What will they do with it?
Personal
Commericial
Resell
Sell as is or customize it with their
own branding

□

Types of Digital Products

□

Top

— How will they use and how often?
Use planners once and toss at the end
of the year, but may return for next
year’s planner

Most into 1 of 4 categories:
— INFORMATIONAL PRODUCTS
ebooks, guides, reference material
— INTERACTIVE LEARNING PRODUCTS
courses, workbooks, follow-along guides

□

16

Creating Multiple Streams of Income

— STATIONERY PRODUCTS
planners, journals, puzzles, coloring books

— Map out your customer journey
— Plug in products needed at each stage

— TEMPLATES OF ANY OF THE ABOVE
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Trending Design
S7 17 -

SUX: The Sustainable UX Manifesto
Digital Impact on the Physical Environment

What to Do

The web emits a lot of CO2

— STOP designing for users only

Gender inequality—higher proportion
of men using the internet than
women in �∕� of countries

— Move AWAY from humancentered design (HCD) to
environment-centered design

Social inequality—access to the internet
can increase a country’s GDP

— Ask ourselves who else is affected
by the products we create?

Climate change worse and faster than expected

— Need to find ways to
consume less energy

Responsibility to the Environment

— Offer more environmentally
friendly solutions (E.g. carousels
consume a lot of energy and yet
don’t engage users; stop using them!)

Designers should also consider their
responsibility to the environment—because
it’s perceived as really difficult to fulfill. As a
result, many designers feel the final project is in
conflict with their personal ideas of protecting
the climate or being sustainable in general.
Designers Have More Power Than They Think
Design-centric companies (like Apple) often
outperform others in the stock market
How to Lessen Design Footprint
We think there are many ways: design less
energy-consuming digital products or
websites, .and use our impact to convince
our clients to be more sustainable.
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Mozilla internet report 2018

— Digital solutions are more
environmentally-friendly
than physical products
— Encourage clients to share their success
stories on sustainability
to raise awareness
— Don’t create unnecessary waste;
not everything needs an app
— Add an additional persona for
the environment when doing UX

17
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— Consider taking on “less cool”
but more “sustainable” clients

— Be proactive. Don’t just post a manifesto
online and garner petition signatures.

LARA LEE

If it would be a country, the web would be
on track to become the fourth largest CO2
emitter on Earth.

The toolkit:
The Miro template provides a step by
step guideline based on well-known
UX-tools.
In a series of 4 Workshops the group
can understand and analyze the SDG
in terms of our work and create
ideas, how to tackle it.
It can be self moderated or we can
provide moderation.

Design Trends
S362 -

Bringing More Style to Your
Typography and Designs
He started with print design but now mostly works w/digital as UI/UX designer
Tips:
— Line the type shine by giving it room to breathe (big, airy, whitespace)
— Use type as a design element
— Give careful consideration to type, esp. since most
of the design tends to be copy anyway
— Follow blogs like Fonts in Use and Typewolf to learn how to pair fonts

18
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— Collect inspo from other designers—but don’t just copy them
— Favorites: Saol Text, Fuji Sans
— Example: Old Lemmon, Helvetica Neue
— Check for ligatures! They’ll work better as the typeface designed ‘em
— Adjust for optical kerning

LARA LEE
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Design Trends

VAR.

S614 -

Type Trends: 2022 and Beyond
— Avoid using trends that become too prevalent
— Some hybrid trends appearing—like Humanist (Frutiger) +
Geometric (Futura) = Avenir which dominated a decade
— Old type in new settings, like “soft-serve serifs” and “Neue nouveau”
— Variable typography really taking off in 2021+ (“VAR”)—
“vehicle to static motion, they morph, they stretch…letting
gravity push and pull the characters….to create an amazing
perspective on this typography and genuine impact”
— “Agile branding”—broader engagement and storytelling

19
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— “Swift, multi-dimensional, exudes confidence” in
tone, size, weight, and frantic movements
— Art noveau emerged in response to the industrial revolution as
manufacturing eclipsed craftsmanship; similarly, Neue nouveau
seems to be emerging in response to increasing automated,
digital design *and my words, here, vulture capitalism)
— “Kinetic posters”
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@pentagramdesign
Monotype.
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Design Trends
S38 0 -

Discovering How to Have Fun with Color Fonts
Standard vs. Color Fonts
STANDARD FONTS come in black by default—it stores information on the outlines
but no additional color information. On the other color fonts, do!
COLOR FONTS come in vector fonts and bitmap (raster) fonts. They can store information
about the outlines’ shades of colors or even store whole PNG images.
BITMAP COLOR FONTS result in a super natural and realistic font. However, bitmap font colors are fixed
to the images and can’t be changed. Additionally, they’re not infinitely scalable like vector color fonts are.
— E.g. Speaker’s own font Liebeheide
Layer fonts assign multiple layers to a typeface which can then be aligned with each other for extra
effect. Color can be changed on each individual font layer…which be make client edits tedious to apply.
— E.g. layer font is Rig

20
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Instead, VECTOR COLOR FONTS store all the layers and color so an edit applies to all layers simultaneously.
Creating the Color Font, Filicudi
Filicudi Color—needed to align the colored lines to letters of varying widths. She solved it by creating
alternate versions of each letter with each color version and exported it in an OTF that automatically
selects the appropriate color version of each character. Speaker uses the font editor Glyphs.
The Future of Color Fonts
**Colors of a colored font are defined by the type designer and cannot be changed by the user.**
However, the type designer can load different color versions from which users can choose.
Color fonts are still a new application, and aren’t broadly supported yet.
However, many Adobe applications do and many web browsers do!
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Project Idea:

Make a font
LARA LEE
L ARALEE . DES I G N
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Product Tutorials
S613 -

Designing for First Glance Attention
Actual scientific data to support your visual design communications choices.
$$$ Plugin costs is $9/month. Full access, which includes web, is $54/month.
What a First Glance Sees:
— Edges
— Intensity
— Color Contrast*
— Faces
*Based on R-G and B-Y, which are human color cones in eyes, vs. CMYK or RGB
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Exercises
1st exercise edges, 2nd exercise R-G contrast, 3rd exercise more difficult
because there’s combinations of different differences (both edges and color).
Human vs. AI First Glance
Field of vision is very narrow, but it’s very intensive. The subconscious
stitches the rest but we’re not actually “seeing” it—brain is guesstimating.
First glance vision is difficult for humans, b/c the brain fills in the gaps. But AI
doesn’t have subconscious vision, so it’s a useful tool to test first glance vision.
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Project Idea:

Test designs
with VAS
LARA LEE
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Product Tutorials
S324 -

What’s New in Illustrator: New
Features, Updates, and More
New Features
— 3D Effects panel upgraded with new substance materials and lighting
— Auto-activate missing Adobe Fonts (like InDesign)
— Link to files in the Cloud
— Work on a live Cloud file to collaborate / comment
— Render and export 3D artwork, can import now into 3rd party programs
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Project Idea:

Illustrate in 3D
LARA LEE
L ARALEE . DES I G N
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Product Tutorials
L 330 -

New Ways to Make 3D Artwork
in Illustrator Workbook
New & Improved Illustrator Features:
— Extrude, Bevel, and Revolve
— *New* Plane and Inflate
— *New* Materials
— *New* Lighting
— *New* Export as .OBJ to import into other 3D programs

26
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Product Tutorials
S8 12 -

Typography, Play, and Animation
Technique #1: Trim Paths on Illustrator shapes […]
— Transform Start and End to “write” text
— Set both Start and End to 0 to open with a blank screen
— Then add an end keyframe for Start 100%
— Later add an end keyframe for End 100% last
— Add some Easy Ease
— Copy Trim Path layer, then copy-paste
that on remaining Timeline layers

27
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— Then stagger timing
Technique #2: Stretch Effect by Merging Anchor Points on Trim Paths
— Import Before / After layers from ILLUSTRATOR
— Direct Select anchor points and bring them to the template
— Added some Scale to overshoot the anchor
points really emphasizes movement
Technique #3: Wiggle Effect with Puppet Mesh
— Add Puppet Pins to shapes—drill deep into
Timeline layer to access transform tools
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Project Idea:

Animate a quote
LARA LEE
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Content Panel
The Content Panel is separated by page. Each page has a drop-down that
holds the content elements within that page. This can include Artifacted
(hidden) elements from the tags tree as well as other interactive elements
and content.

Product Tutorials

Items in the Content Panel are arranged bottom to top. Meaning, items
nearest the Page 1 marker are in the back of the document. Items at the
bottom of the Page 1 content list are in the front or on top of the other
elements in the list. This matters when you are adjusting the Read Order
and something goes “missing.” Typically this happens because the missing
element was re-ordered behind the other elements. Just drag the missing/
hidden element to the bottom of the list to make it reappear.

L200 -

Learning the Fundamentals of PDF
Accessibility Step by Step
Need Acrobat (NOT Reader DC)
to automate / manually complete
changes to increase accessibility
Start with assigning a Document Title
and Language to the PDF with Document
Properties [Cmd + D] in ACROBAT
DC so that it vocalizes correctly
Add Bookmarks from headings [sidebar]
Consider grouping Tags as well [search
tools, then it appears in sidebar]
Most popular screen readers don’t look at Order
panel anymore, and editing here also updates
tags (don’t want)—instead look at Content
panel to maintain your cleaned-up tags tree
Add Accessibility panel to Tools panel, right

Preparing InDesign to Minimize Acrobat
Post-Production Work Later
Use tables only for data, not layout

What you find in the Content Panel

Can add tags from the get-go in
InDesign with Window > Utilities > Tags
that Acrobat can import
*More info here and here

Annotations: These are the list of Link-OBJRs on that page.
Containers: Each element is listed with its Parent container
Artifacts: Decorative elements to be hidden from the screen reader.
Form XObjects: Repeating elements typically created on Master pages. These objects
only get stored once in a PDF but referenced multiple times. Consider Form XObjects
as mini-PDF files embedded inside the main PDF document
5. Untagged Content: Content that is not in the Tags Tree nor has not been tagged as
an Artifact will appear without the word Container before it.
1.
2.
3.
4.

Assign descriptive alt text to
InDesign images AND links
Manual Checks
— Manually verifying color
contrast and color blindness

29
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Tools That Beginners Should Double-Check

“Description” is the alt text for an object
To add tags, use More Tools >
Accessibility > Reading Order
Don’t use Accessibility Checker > fix
errors on a decorative Figure—there’s a
bug that produces a non-semantic tag
Organize Pages > select all + right-click
> Properties > set to Document Order
Tables may produce a lot of errors b/c
automatically-generated HTML may
not account for colspan and/or rows
pan. Verify in Table Cell Properties

LARA LEE

— Auto Tag can be really, really off
— When renaming tags, Acrobat will
auto-complete the closing HTML
brackets on Enter

1
2

5
3

4
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Project Idea:

Adobe MAX — The Creativity Conference

Learning the Fundamentals of
PDF Accessibility Step by Step
Dax Castro, ADS | Vice President of ADAcademy, AbleDocs

Tag a PDF

The Acrobat Workspace

30

Adobe Acrobat has three basic views and four areas to access tools and
commands. Understanding what is in each of these areas will help you
develop the best workflow for your situation.

The Four Interface Areas
1 . The Text Menu
The text menu at the top of the screen allows you to access every tool and
command through a series of drop-down menus. Acrobat allows keyboard
and mouse-driven access to these commands.

Top

2 . The View Tabs
These consist of the Home, Tools and Document tabs. They allow you
to switch between interface modes and provide quick access to recent
documents, tools and your document(s).

3 . The Panes Panel
These are the elements to the extreme left of the screen. You may have
more or less tools in this panel. You can add tools by right clicking in the
open area under the last tool and selecting the desired tool to add from the
pop up list that appears.

1

2

3

4
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Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro | Adobe MAX 2021

Reading Order Panel Explained
1. Tagging Tools: Draw a box around any element on the page and then
Click the appropriate button to tag that element. Your tag will appear in the
next logical order below your currently selected element in the Tags Tree,
Order Panel or Content Panel.
2. Table Editor Tool: Allows you to edit table properties for header and data
cells. When you click on the table the Reading Order Panel will disappear.
You can select it from the Tools Panel to reactivate it.
3. Table Summaries: These can only be edited by selecting your table, right
clicking and choosing Edit Table Summary.
4. Visual Options: These options allow you to group and ungroup similar
items in the Reading Order view as well as show or hide tables, table cells
and figures.

LARA LEE
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Learning the Fundamentals of PDF Accessibility Step by Step
Dax Castro | Adobe MAX 2021
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Planning

Product Tutorials
S619 -

Getting Design Done: How to Manage
Projects Less and Create More

●
●
●
●

ADOBE MAX 2021

Start with the customer.
Use data to define goals.
Map individual work to overall
goals (OKRs).
Shorten cycles and communicate
at every stage.

Opening exercise on Scope Creep: you have 90 seconds
to draw a car…then a house….and a tree, too!
His company uses WRIKE
Set up custom scripts to automate repetitive tasks in Wrike, like:
— remind stakeholders to review an asset,
— move a job on hiatus to a backlog,

31
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— archive final files when job is marked complete,
— etc.
(They are available via rules Wrike users can set up)

Top

Design Workflow

Core:

Pending

Design Review

Additional:

Processing

Accepted

Stakeholder Review

Waiting for Others

On Hold

Research

Design Approved

In Design
Completed

Cancelled
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Product Tutorials
L577 -

Improving Efficiency with After Effects
Power Tips
Organize footage into folders:
— Audio
— GFX
— Video
Then leave comps outside for easy access.
Double-click Asset panel background
to launch Import window
Alt-drag an asset onto the canvas to replace a
layer snd retain names/effects/transforms (p7)
Take advantage of Animation Presets
Can preview the Animation Presets,
too, in Browse Presets (p8)
Check out Behaviors to automate
simple transforms (p14)

Latest AFTER AFFECTS release has big
improvement on render performance with
MULTI-FRAME RENDERING that caches
previews automatically when mouse
movement is detected, and leverage
more of computer hardware to render
Preview how long each layer needs to
render with Poster Time by clicking Snail
icon in bottom Timeline panel (p17)
Save render time by marking unchanging
areas of layers with the layer’s Region of
Interest and Crop—make comp copies
first though, this editing is destructive
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Speaker sets export Output Module to High
Quality as render method (vs. Lossless)

Hit Home key (by Delete) to move
scrubber back to beginning
Bring back missing layers—layers with content
beyond ILLUSTRATOR’s pasteboard—by
double-clicking to edit original in Illustrator
and drag a new dartboard around it all.
Recommend to re-import the file at this point.
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ADOBE CAPTURE

L 332 -

Designing Scalable Marketing
Assets with Illustrator
Beginner’s Illustrator tutorial

Download the Adobe
Capture app on your mobile
device by going to the
AppStore or Google Play..
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Use Adobe Capture on your mobile to extract a color palette from
your environment using the live camera. You can also access images

LARA LEE

saved on your mobile devices and extract from those.
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Making MOGRTs with Mo and After Effects
What Is a MOGRT
Motion Graphic templates or MOGRTs
(pronounced like yogurt)
How to Make/Export a MOGRT
to Adobe CC Library
Start in After Effects, make sure
Essential Graphics panel is active
Create composition
When complete, return to Essential Graphics
Prepare to export
***IMPORTANT*** Assign a good name—
it can’t be renamed once in the Adobe Library
Drag-drop Timeline layer into the Essential
Graphics panel to create the first template

Session discusses uses the MOGRT in
Premiere Pro, but Google search shows
that they can still be opened in After
Affects as Open Project > Extract
RESPONSE TO COMMENTER QUESTION:
When adding a MOGRT to a sequence all
you are doing is refereeing to it like a link.
The original will never be changed,. Its non
destructive. Trust this answers the question
COMMENTER ADDED: A “hidden” feature is,
if you create an updated version of a Mogrt
(IT MUST be from the same AE project)
you can alt-drag replace the new version
in Premiere, and it will keep the text etc.
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Assign the template layer a name then
assign what attributes can be edited
——> Follow along in PDF,
too fast/blurry to keep up
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Creatives Are Not Robots: Letting
Automation Do That for You
Spend more time being creative and less time doing repetitive,
mundane tasks that make you feel like a robot.
Introducing Adobe Cloud APIs
PDF Services
Compresses and optimizes PDFs as they’re uploaded to the website
Photoshop API
Create a template in PSD and it’ll isolate each speaker photo,
position, add session info, and add background automatically
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Adobe Document Generation
Creates and formats documents for website users
Open the template’s JS tags right in MS Word so developers
can also edit it in a program with which they’re familiar
Adobe PDF Embed API
Like an iframe for PDFs so users can read the PDF without leaving the window
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Creating an Animated and
Interactive Infographic
Step 1: Animate and Export Assets
He animated in ANIMATE
(new Flash) and exported
as PNG sequences.
He exported the ILLUSTRATOR
assets as PNG@3X—Adobe Aero only
accepts PNGs and GIFs, and not EPS.
Then you must ZIP the PNG
sequence folder to be able
to import into AERO. It’s
simpler to save these over
the CC LIBRARY because…
Step 2: Import Assets to Aero
You’ll open AERO and first need
to scan a surface before crafting
the interactive animation—so
unless you can dance around
with your desktop computer, a
tablet or phone might be easier!
Scan the surface. Click the + icon
to place the assets to position
and scale appropriately. Import

static like normal, then import
the ZIP for the animated assets.
Previewing right now won’t
play the animation—you
must add a behavior first.
Tap the asset to add behavior and
select Play Images (NOT animation,
since these are PNG sequences).
Enable Infinite to loop the
animation instead playing once and
stopping. Now the Preview will play.
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Then place the button PNG
sequence. Set it to infinite. We’ll
need to add a behavior and select
a a trigger and start action.
Then place the first pop-up. To
toggle visibility, go to the Layers
panel on the bottom right and
hit the eye icon to hide it first.
Then return to the button,
return to behaviors, and add a
trigger for Tap. On Tap, set the
action to Show the pop-up.
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Create an AR
illustration
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Essential Editing Techniques for
Creating Realistic Composites
Use Object Tool to quickly select subjects
Mask Refinement
Can globally refine a mask to remove “fringing”
(that highlight where the old background still
shows through) with Filters > Minimum to
shrink whole mask and crop off that fringing
Match light source shading by masking
a Curves adjustment layer
Match light source shading by masking
a Curves adjustment layer
Create a new solid fill of 50% gray then
change blend mode to Luminosity
Create a new Hue/Sat adjustment
layer and max out saturation
Group the two adjustment layers:
your “Ambient Color Check”
Look at the warm vs. cool colors—
the new material should match the
oranges/blues of the original

Match ambient lighting saturation:
Add new Selective Color check above
the ambient lighting temperature
Sel Col adjustment layer
Set each color to 0% and Black to -100%
Go to until Whites and set Black to +100%
On Blacks, increase Black to +100%
The result in a B&W image. Bright
areas have a lot of saturation while
dark areas have no saturation.
The saturation levels should make sense.
Choose either the original or the new
material layer(s) and add a new Hue/Sat and
increase/decrease saturation so it blends
in. // Identify whether the background
or foreground is mismatching, then add
another Hue/Sat and adjust the saturation

Adjust Brightness

For a composite to look realistic, you have to match the contrast, the brightest, and darkest areas. To
get a better representation of the brightness in the composite you can create a “check layer.”
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Go into the New Adjustment Layer Icon and select Black and White. This will desaturate your composite
and you will be better able to see the brightness of your image.

Match depth of field:
Mask out a Gaussian Blur layer to
recreate the blurred objects

Add a Selective Color adjustment
layer and adjust the CMYK levels so the
new material brings in an appropriate
mixture of oranges/blues
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Advanced Compositing for Brands,
Photography, and Type
This was relatively basic using masks, free transforms, and liquify filter. Example
#3, consider a displacement map which is more automatic over the liquify filter.
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Thanks!
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